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Measuring Habitat Quality (Omniscape Source Layer)

Defining a habitat quality map to serve as a “source” layer for Omniscape is the first step in measuring
habitat connectivity. Such a map is also valuable in and of itself for stewardship decision making and it
is a key indicator in the LA City Biodiversity Index (Indicator 1.1b). In California, habitat quality
assessments are most frequently performed for individual or groups of species of conservation concern
based on the State and Federal Endangered Species Act, often as a result of potential negative impacts
to habitat and associated compliance with the California Environmental Quality Act {CEQA). Less
common approaches address broader suites of species and ecosystems of similar conservation concern
in comprehensive conservation planning projects such as California’s Natural Communities Conservation
Plans (NCCP’s) (CDFW 2018). While more comprehensive habitat quality data, such as NCCP’s, are
available for various sub-areas of the study area, only datasets with complete coverage were considered
in order to provide uniform results.

A newer Combined Habitat Assessment Protocol (CHAP) is also being applied by governmental
agencies. CHAP assigns habitat value to different vegetation types considering species in the California
Wildlife Habitat Relationships (CWHR) dataset (CDFG 2008). CHAP modeling has been performed across
the entire study area (e.g. SCAG 2015); however, results are provided at a coarse-resolution and
valuation strongly emphasizes native wildlife species of conservation concern typically found within high
quality natural areas. The dataset accounts very low value, with little differentiation, across urban land
uses that are home to mostly common native species. Connectivity or size of patches of habitat are also
not considered in CHAP habitat quality valuations. The CHAP model is also proprietary and methods
details for how vegetation was valued as habitat for wildlife species could not be determined.
Therefore, the dataset was not incorporated into habitat valuation considerations, but could be in the
future. The Green Visions Plan by Rubin, Rustigian & White (2006) also used CWHR data combined with

Southern California Council of Governments Landcover Types to estimate habitat potential across the
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urban matrix for a set of target species of conservation concern. The full dataset could not be easily
acquired and reconciled, and therefore, was not incorporated into this analysis.

This study expands upon this previous work to provide a more high-resolution, City-wide
assessment of habitat quality for overall native biodiversity in both urban landscape and open space
areas at a 10-foot (3.05 meter) resolution. Interpreted high-resolution, 6-inch aerial infrared remote
sensing and LIDAR data resulting from the 2016 LA County Tree Canopy Assessment was resampled to a
10-foot pixel size and was used as the base layer for assigning habitat quality values (SaveATree
Consulting Group 2016). This dataset also includes classification of all lands within the County classified
into several types, in addition to tree canopy, and was refined and reclassified based on additional
spatial data on native vegetation from several relevant, open source datasets described below. A 10-
foot resolution is small enough to detect individual trees or yards in urban areas and supports a variety
of local-scale stewardship objectives, including detailed biodiversity monitoring and planning at the
parcel-level, prioritizing locations for protection and enhancement in both natural and developed
landscapes, or for planning public access to biodiversity.

Like the CNS study, estimation of habitat quality is based on a measure of naturalness of
landscapes across the study area, rather than suitability for individual species. When applied at broad
scales, each of these approaches rely on remotely sensed landcover data and some level of expert
judgement about the relationship between landcover and the presence of species (CDFG 2008, McRae
et al. 2016). | combine considerations of two factors, vertical structural quality of vegetation
(“vegetation type quality”) and landscape patch size (“patch size”), into an overall habitat quality score
for each pixel. Individual pixel scores for vegetation type quality and patch size were then added
together and weighted for a maximum potential habitat quality score of 10 points per pixel. The
detailed measurement methods, including GIS analysis steps, for habitat quality are described in

Appendix F.
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Detailed methods for measuring vegetation type quality, including GIS-application steps, are
provided in Appendix F, Section 3.2, and are summarized as follows. Vegetation type scores are
reported on a 5-point scale, with 5 representing the most natural (i.e. natural areas) and 1 being the
least (i.e. typically monocultures lawns or similar). The 2016 LA County Urban Forest Canopy
Assessment classified vegetated pixels into relevant types that provided the initial basis for scoring most
pixels. Additionally, the CALVEG dataset was further used to classify vegetated pixels in natural areas
(CALVEG 2004). Data on streams was also used to ensure that these important habitats were fully
accounted for, including locations of large culverts under roadways that provide some habitat
connectivity value. Finally, iNaturalist observations of native plant species were used to account for
small urban natural areas and native plant landscapes, especially in highly urban areas. Scoring
assumptions for each of the above datasets are presented in Appendix F, Section 3.2.2, Tables 1-3.
Mapped scores for vegetation type quality for the full study area are provided in Figure 3-5 below.

Detailed methods for measuring habitat patch size, including GIS-application steps, are provided
in Appendix F, Section 3.3, and are summarized as follows. All vegetated pixels were isolated into
contiguous regions (patches) that were then scored 1 to 5 based on patch size. The correlation between
patch size and habitat quality is a well established principle of conservation biology and landscape
ecology (Dramstad, Olson & Foreman 1996). Scoring assumptions for patch size thresholds are provided

in Appendix F, Section 3.3.2.4, Table 1. Mapped scores for patch size are provided in Figure 3-5 below.
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Figure 3-5: Scores for vegetation type quality {left) and patch size (right). These scores were weighted and
combined to produce a total habitat quality score based on a 10-point scale.

Detailed methads for combining vegetation type quality and habitat patch size scores, including
GlS-application steps, are provided in Appendix F, Secticn 3.4, and are summarized as follows.
Individual pixel scores for vegetation type quality and patch size were added together for a maximum
habitat quality score of 10 points per pixel. All pixels scoring 5 for vegetation type quality (i.e. native
vegetation) were weighted so that no pixel containing native vegetation could score less than 7 total
points, regardless of patch size, according to the rules described in Appendix F, Section 3.3.2.4, Table 1
(i.e. native vegetation types are weighted higher in importance for native biodiversity than all other
vegetation types or patch size criteria). The resulting dataset also serves as the measurement of LA City

Biodiversity Index Indicator 1.1b. Habitat quality scores were used as the basis for Omniscape “source”
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layer described in the following section. Total cumulative scores for the study area are mapped in Figure

3-6, and a detailed view for the Elysian Valley test area is provided in Figure 3-7.
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Figure 3-6: Habitat Quality scores/Omniscape source values for the study area.
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Elysian Valley: Omniscape Source Weight
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Figure 3-7: Habitat quality scores/Omniscape source weights for the Elysian Valley test area.
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Estimating Resistance to Species Movement {Omniscape Resistance Layer)

The Source Layer was combined with the Southern California Council of Governments (SCAG) 2008 Land
Use layer to produce the resistance layer for species movement in Omniscape. This regional land use
map aggregates local municipal land use maps from the numerous local planning agencies within the
study area. The specificity of each of the 100 land use types in the resulting dataset, and the precise
polygon delineations, provides a detailed estimate of land use intensity and boundaries suitable for
converting to the relatively high 10’ pixel resolution of this study. Many of the 100 land use types
provided were relatively duplicative because they represented different local naming and classification
conventions for the same general land use. | reviewed the descriptions of each type and reclassified
them into 15 general types based on assumed land use intensity and potential resistance to species
movement (see Table 3-1). Refining resistance values considering road traffic volumes, more detailed
land use for the City of Los Angeles, building footprints, and other mapped barriers is a planned next
step for application.

While Rubin, Rustigian & White (2006) did not address habitat connectivity, they estimated
potential habitat suitability in urban Los Angeles based on an earlier version of SCAG land use and land
cover types and considering literature review combined with expert judgement for multiple target
species. McRae et al. (2016) based resistance on land cover type assigned in the National Landcover
Dataset (NLCD), and they selected resistance values based on expert judgement of the relationship of
intensity of land uses to the potential for species movement. NLCD land cover is somewhat different
than land use types from SCAG in that land cover types reflect dominant physical surface characteristics
detected using remotely sensed imagery at a 30-meter pixel resolution, whereas SCAG land use is based
on uses allowed under local zoning law and are spatially defined by more precise legal parcel
delineations. In addition to the relatively coarse spatial resolution of NLCD, another drawback is that

there are significantly fewer classes of urban landcover than SCAG land use types, and they do not
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consider different types of activities within land covers that may reflect the same general physical
surface characteristics when sensed remotely using satellites. SCAG land use types provide additional
information relative to types of activities occurring within them, such as commercial activities which
may have stronger impacts on movement than other land uses of similar surface characteristics.
Additionally, since NLCD also assigns land cover type based on dominant characteristics within the pixel,
pixels with lower amounts of vegetation may be classified as an urban land cover type and pixels slightly
dominated by vegetation may be classified as a vegetated type, but may still include some urban land
uses.

The approach presented here is somewhat of a hybrid between purely landcover and land use-
based approaches. First, | consider remotely sensed surface cover for differentiating vegetated vs. non-
vegetated pixels using the 2016 LA County Urban Forest Canopy Assessment dataset and CALVEG. |
assigned vegetated pixels, regardless of the underlying SCAG land use type they fall within, with
relatively low resistance scores based on their source values, but reversed (i.e. source scores of 10
receive a resistance score of 1, 9 =2, 8 = 3, etc.). Adjusting vegetated pixel resistance based on
underlying land use context may be appropriate in this more urbanized area and should be explored as a
next step in application. Next, | assigned resistance values to non-vegetated pixels based on the
underlying SCAG land use type. Values of 23 to 300 were given for non-vegetated pixels, which reflects
similar values to McRae et al (2016). Land uses, such as commercial and high rise residential, were
assumed to produce higher “edge effects”, such as light, noise, traffic, or litter, or other land use
impacts that may reduce native species movement and were given the highest resistance values. Non-
vegetated pixels within land uses such as low density residential and open space were given the lowest
resistance values since they were assumed to produce less edge effects. Campus, office, and industrial
land uses were given moderate resistance values. The ocean was given a “no data” value because this

study is intended to assess terrestrial permeability only (including small water bodies).
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A crosswalk of resistance values by SCAG land use type and habitat quality (source value) are
provided in Appendix G, Section 3.2.4, Table 1. The 15 resulting land use types and associated
resistance values used in the modeling are presented in Table 3-1 below. The overall study area
resistance map is shown in Figure 3-8 and the Elysian Valley test area is shown in Figure 3-9.

Table 3-1: Resistance value calibration of the omniscape model for the Elysian Valley test area. Source values were
used as resistance values for vegetated pixels regardless of land use context. Non-vegetated pixels were given
higher resistance values based on a reclassified version of SCAG’s 2008 land use types.

Vegetated Pixels
Pixel Type Resistance Value
Reverse of Source Value (10=1,
Source Values 1-10 9=2, etc.)
Non-Vegetated Pixels (Source Values 0)

Pixel Type Resistance Value
General Open Space 23
Vacant 25

Low Density Residential 30
Campus 30

Water Infrastructure 30
General Agriculture 30
General Water 30
Medium Density Residential 40

Under Construction 45

High Density Residential 50

Office 60
Insustrial 75
Transportation 75

High Rise Residential 150
Commercial 300
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Figure 3-8: Resistance weights for land use and land cover for the overall study area.
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Elysian Valley: Omniscape Resistance Weight 0 03

M2 (05 (J8 [J23 W40 EMeo MH300
B3 [CJe [Jo [J25 W45 EM75 [ _iCity of Los Angeles Boundary

4 [J7 [J10 EH30 EEs0 150

Figure 3-3: Resistance weights for the Elysian Valley test area.

Measuring Habitat Connectivity {Omniscape Modeling)
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Omniscape uses a moving window process to test connectivity of each individual pixel to pixels
surrounding it to a certain specified distance (i.e., the window). It combines measurements for each
pixel into an overall “current flow” map for the area of interest suggesting levels of potential species

IH

movement. In this way, Omniscape creates a “wall-to-wall” connectivity map, as opposed to mapping
connectivity between pairs of core habitat areas, which is often done when mapping specific, individual
corridors using older Circuitscape software. The size of the moving window determines how far to
evaluate potential connectivity, and a small moving window would test only local connectivity, while a
larger window tests longer distance connectivity. Both local and long distance movement of species is
seen as necessary for species and ecosystems to adapt to climate change, and my assumption is that
local and long-distance movement is also necessary for urban ecosystems and biodiversity within
fragmented urban habitats to adapt to urban or climate change stressors (Anderson et al 2012).

I used Omniscape version 1.2 through the Julia operating platform to run this analysis

(https://circuitscape.github.io/Omniscape.jl/stable/, https://julialang.org/downloads/). The results

presented here are for a local connectivity within a 2 mile (0.8 km) window of each pixel across the 1.4
million, 30" resolution pixel Elysian Valley test area. 10’ pixel resolution provided for the source and
resistance maps was resampled to 30’ in order to reduce computing power requirements but still
provide relatively high-resolution results. The ¥ mile window is assumed to represent a measure of
local connectivity of habitat pixels. Modeling a long-distance moving window, planned as 5 miles (8 km),
was computationally prohibitive using my currently available systems.

Julia requires a specific set of file formats and code steps to run Omniscape and the code used
for the Elysian Valley test area is provided in Appendix G, Section 3.3. Underlying computational details
of Omniscape are described in Anantharaman et al. (2019). While the underlying computations in
Omniscape are complex, the run codes are relatively simple and require just a few basic calibration

steps. The only calibrations with significant underlying ecological measurement implications are the
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moving window size, resistance, and source weights. Other omniscape calibrations within this code are
designed to optimize model run time based on computing power constraints and model output formats
(e.g., block size, # of parallel processes, normalized current map, etc.) and are described in the

Omniscape websites provided above.

Results

The basic Omniscape output is a “current flow” map within the area of interest (see Figure 3-10). As
was mentioned previously, results are presented for the 1.4 million pixel sub-area, the Elysian Valley test
area. Results demonstrate local-scale connectivity using a 2 mile moving window. A larger analysis
extent and higher computing power is necessary to measure long-distance connectivity using the 5-mile
window; however, local-scale connectivity mapping also partially reflects these longer-distance

connections.
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APPENDIX F: Habitat Quality of Landscapes and Open Space GIS Methods

1. Datasets Used:

1.1.

1.2.

1.3.

528 | Appendix C

Dataset 1 Name: LA County Tree Canopy Assessment 2016 (Based on LARIAC 20147)
(Propriatery)

1.1.1.Dataset Filename: landcover_2016 losangeles.tif

1.1.2.Dataset Location:
D:\TreeCanopy_LosAngeles 2016.gdb\landcover 2016 _losangeles_countywide mosaic\la
ndcover 2016 losangeles countywide mosaic

1.1.3.Reference: https://www.treepeople.org/sites/default/files/pdf/tree-canopy-
data/Tree%20Canopy%20LA%202016%20Report FINAL%2020190425.pdf

1.1.4.Original Source: https://egis3.lacounty.gov/dataportal/lariac/lariac-archives/lariacd-

archive/

1.1.5.0Original Source Metadata:

1.1.6.Dataset Discussion: Includes landcover classified into 8 classes by University of Vermont
team for LA County. Original dataset has 0.75 foot resolution.

1.1.7. Citation: SavATree Consulting Group, University of Vermont Spatial Analysis
Laboratory, TreePeople, & Loyola Marymount University Center for Urban
Resilience. (2016) Los Angeles County Tree Canopy Assessment, 2016.

Dataset 2 Name: CALVEG Southern Coast Section
1.2.1.Dataset Filename: ExistingVegSouthCoast2002 2010 v2.gdb
1.2.2.Dataset Location:

1.2.3.0riginal Source:
https://www.fs.usda.gov/detail/r5/landmanagement/resourcemanagement/?cid=stelprdb
5347192

1.2.4.0Original Source Metadata:

https://www.fs.fed.us/r5/rsl/projects/gis/data/vegcovs/scoast/ExistingVegSout
hCoast2002_2010 v2.html

1.2.5.Dataset Discussion: Only complete and uniform dataset of natural vegetation available for
the entire City. Some level of error due to statewide extent and resolution. This dataset
does not identify small natural, naturalized, or restoration areas well. Also, data was
collected over 10 years starting approximately 1998 which will result in some error due to
landcover change.

Dataset 3 Name: LA County Department of Parks and Recreation Parks and Open Space

1.3.1.Dataset Filename: DPR_COUNTYWIDE_PARKS_AND_OPENSPACE
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1.3.2.Dataset Location:

1.3.3.0riginal Source: https://egis3.lacounty.gov/dataportal /2016/10/25/department-of-parks-
and-recreation-county-parks-and-open-space/

1.3.4.Dataset Discussion: Includes all City and County parks and open space including park
program elements. National forests aren’t included.

1.4, Dataset 4 Name: LA County CAMS Streets & Addresses 2014
1.4.1.Dataset Filename: CAMS.gdb
1.4.2.Dataset Location: \\htpgis3\General_Users\RAD

1.4.3.0riginal Source: http://egis3.lacounty.gov/dataportal/2014/06/16/2011-la-county-street-
centerline-street-address-file/

1.4.4.Dataset Discussion: Includes streets, roadways, rail, trails, etc., and related information for
Los Angeles County.

1.5. Dataset 5 Name: SCAG Los Angeles Countywide Zoning 2008
1.5.1.Dataset Filename: zoning_countywide.shp
1.5.2.Dataset Location: \\htpgis3\General_Users\RAD

1.5.3.0riginal Source: https://egis3.lacounty.gov/dataportal/2012/04/10/countywide-zoning/

1.5.4.Dataset Discussion: Includes detailed zoning normalized by SCAG for all Cities in the
County. “Zone_Code" field is most detailed and includes densities. “SCAG_GP_CO” field
includes less detailed descriptions used in the County general plan. This field was
referenced in this analysis to identify schools.

1.6. Dataset 6 Name: LA County Department of Public Works Storm Drain Network
1.6.1.Dataset Filename: SDN_Public.gdb
1.6.2.Dataset Location: \\htpgis3\General_Users\RAD

1.6.3.0riginal Source: http://egis3.lacounty.gov/dataportal/2013/08/08/los-angeles-county-
storm-drain-system/

1.6.4.Dataset Discussion: Used to identify open channels and streams. Includes some additional
information/different information than the NHD dataset (below) but includes few natural
streams. Many natural streams within LA (especially Hollywood Hills) are missing from
both datasets.

1.7. Dataset 7 Name: National Hydrography Dataset
1.7.1.Dataset Filename: nhd_flowline_withcodes.shp

1.7.2.Dataset Location: \\htpgis3\General_Users\RAD
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1.7.3.0riginal Source: http://egis3.lacounty.gov/dataportal/2013/08/08/los-angeles-county-
storm-drain-system/

1.8. Dataset Discussion: Mainly used to identify streams. Includes many more natural streams that
the DPW “Stream/River” dataset. However, many known natural streams within LA (especially
Hollywood Hills) are missing from both datasets.

2. Other Datasets Considered

2.1. NWF Certified Habitat gardens/schools. This dataset could be used in a similar way to
iNaturalist data by assigning addresses that are certified a score of 5 for the parcel. However,
NWF addresses are not to be shared with the public and would need to be modified, possibly
by assigning scores based on broader-scale pixels instead of parcels.

3. Methods
3.1. Extract and resample UVT LARIAC (2016 Canopy Assessment per above) Landcover raster

3.1.1.Extract pixels for study area extent boundary (extract by mask using a 10ft pixel rasterized
County boundary clipped to the square version of the ecotopes extent boundary
(“Charbdryl...20km").

3.1.2.Extraction will result in resampling of the 0.75" pixel UVT LARIAC raster to a 10’ pixel size
(extracting “nearest” pixel value to determine pixel value of the 10’ pixel. Maximum is
preferred but couldn’t figure out how to get it to work.

3.1.3.Expand extent of UVT LARIAC raster file to analysis extent because it doesn’t include areas
of Orange or Ventura County (See Chapter 2, Ecotopes for discussion of analysis extent).
The habitat quality layer will ultimately be used to model habitat connectivity indicators
using Citcuitscape/Omniscape, and connectivity analysis requires an extent broader than
the City boundary to improve connectivity modeling accuracy within the focus area.

3.1.3.1. Convert Ecotopes extent rectangular boundary file to a 10ft raster. (filename:
CharBdryl S5kmNSW_wshdNE_20kmE).

3.1.3.2. Use “Cell Statistics” tool in ArcGIS. Spatial Analyst>Local>Cell Statistics. Add
boundary file and UVT LARIAC File, overlay statistic="Maximum”, check box to ignore
no data cells. Edit no data cells to have value 999.

3.1.3.3. Do the same for other data layers including streams, iNaturalist and CALVEG.
There were issues with the extent of the output and it was necessary to open the
Environments dialog box in the Cell Statistics tool and select Processing Extent>
Extent item to "Union of Inputs".

3.2. Score Vegetation Type Quality of Landscapes.

3.2.1.For areas within or outside LA County, score the pixels of the UVT LARIAC raster based on
the following rules by combining UVT LARIAC raster, Classified CALVEG raster, streams
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(NHD and DWP datsets), and “barefix” raster, which scores bare soil that is ballfields from
the UVT LARIAC per rules below. File name is 1.1bhabqual#

3.2.2.All files need to be converted to raster files per metehods in 3.1 and combined into a
master raster with all relevant fields and scored in a “Max” field according to the following
rules. Note that CALVEG needs to be made into a wall to wall raster for the study area.
The ocean is excluded, so union with boundary and give ocean a unique value to address in
raster combining.

1.1b Vegetation Type (Habitat Quality) Scoring Rules

LARIAC
Landcover Score
Type Score 0 1 Score 2 Score 3 Score 4 Score 5
Buildings All pixels
Roads/Railro
ads All pixels

Other Paved | All pixels

in CALVEG
Natural Areas,
iNat research

All in CALVEG grade native
other Degraded plant
Grass/Shrubs pixels natural areas observation
in CALVEG

Natural Areas,
iNat research
grade native
All other plant

Tree Canopy pixels observation

in CPAD 2019
Local Parks with | All other
Baseball Fields pixels

or SCAG 2005 (includes
Land Use Elem, | smaller

Jr, and High degraded
Schools (most of | natural areas
this appears to | and some dry

be ball fields so | natural areas in CALVEG
scoreof2isa not detected Natural Areas,
compromise in CALVEG, iNat research
since some but also a lot grade native
degraded of urban bare plant
Bare Soil natural areas soil too) observation
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might be in this
class too)
in CALVEG
Natural Areas,
iNat research
grade native
All other plant

Water pixels observation

Tall Shrubs All pixels

Dataset Score 0 | Score 1 | Score 2 | Score 3 Score 4 Score 5

LA County “Open Channel” | Other “Open “Natural

Department and LARIAC Channel” (Except | Drainage”

of Public score of 0 CALVEG or LARIAC

Works score of 5

Stormdrain overrides)

Network

National “Artificial Path”, | Other “Artificial Description

Hydrography “Canal/Ditch”, Path”, Field:

Dataset “Connector” “Canal/Ditch”, “Stream/River”
and LARIAC “Connector” of any type
scoreis0 {Except CALVEG {three types)

or LARIAC score of
5 overrides)

Datase Scor

t Score 0 Score 1 e2 Score 3 Score 4 Score 5
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All other Degraded
non-native Natural
CALVEG Non- vegetation Areas
Native (including (includes
CALVEG ornamental Urban CALVEG
Urban or grasses or Agricutlture, | "Water" and
Developed Agriculture remaining remaining
(classification | (classification classification | classification
s per 2018 s per 2018 s per 2018 s per 2018
CALVE | Biodiversity Biodiversity Biodiversity | Biodiversity | CALVEG Natural
G Report Report Report Report Areas, Known
Datase | Appendix B Appendix B Appendix B | Appendix B | Restored/Constructe
t Indicator 1) Indicator 1) Indicator 1) | Indicator 1) | d Habitat Areas

Notes: There are various levels of error in these datasets and assumptions on the above scores
represent effort to accommodate this error. On gound-field truthing at sites of interest should be
performed if/when this dataset is used to evaluate site conditions. Some error may be corrected with
further data processing. Key sources of error include:

e The UVT LARIAC dataset combines grass and shrubs into one class. Isolating grass and giving
that a value of 1, and giving shurbs a 2 or a 3, would improve detection of native and non-native
shrub areas.

¢ Some native chapparal classified as “tree canopy” in UVT LARIAC. Much of this is corrected by
through integration of CALVEG natural areas which result in score of 5 for these areas of canopy.

¢ Some annual grasslands and native shrubs classified as “bare soil” or “grass and shrubs” in UVT
LARIAC.

e Some Annual Grasslands (Degraded Natural Areas) in CALVEG are misclassified areas of urban
development or urban bare soil. Therefore, these classes have not been included within LA
County except to bump up scores of grass/shrubs due to potential for native species.

e Not all perennial or ephemeral streams are mapped within the study area, especially those on
private property including the Hollwood Hills.

3.3. Score Patches of Landscape/Canopy based on Patch Size

3.3.1.Note: Considered using streets as breaks in patches, however, decided against it since UVT
LARIAC is so detailed large street with no overhanging tree canopy are detected as breaks.
Overhanging tree canopy or vegetated bridges/tunnel overpasses detected in UVT LARIAC
are assumed to constitute connectivity. | tested using CAMS Streets to break paches,
however this reduced accounting of connectivity benefits of overhanging tree canopy, it
also resultd in removing any vegetated tunnel overpasses (e.g. Elysian Park over the 110
and likely future habitat bridges). Singapore Index requires considering 15 meter or wider
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streets as breaks. Again this wasn’t necessary since LARIAC will account for breaks from
streets as small as 10’ (pixel size). Additionally, few streets over 15 meters have
contiguous canopy, so most are considered breaks in paches in LARIAC as well. Canopied
streets over 15 meters (if they exist) are assumed to be beneficial for connectivity and not
counted as breaks in this measurement.

3.3.2.Differentiate and score patchs based on size

3.3.2.1. Use UVT LARIAC for LA County and CALVEG for outside of LA County to identify
patches of habitat. Any landscape/canopy or water detected by satellite is
considered part of a patch. Combine LARIAC and CALVEG. Add “Field Name” and
edit scores for all landscape/canopy as score 2 and all built, streets, streets, etc as
score 1

3.3.2.2. Use “Lookup” tool to create new raster from “Field Name” field with values of 1
or 2. Spatial Analyst>Reclass>Lookup

3.3.2.3. Use “Regional group” tool to group pixels from Lookup file into patches. Spatial
Analyst>Generalization>Region group. Set “score 1 (or whatever value used for
developed lands” values as “no value”. Set “number of neighbors to use” to “4”
(default, most conservative).

3.3.2.4, Score patches (region value 2 in “Field Name” field) based on region size (i.e.
“count” field for # of 100 square foot pixels) based on following rules.

Patch Size Range Score Justification for Score Threshold

500 sf or less, except when Vegetation | 0
Type score is 5, then those pixels 3

>500 sf to <0.5 acres {count 5 to 1 500’ is project threshold in LID
<218}, except when Vegetation Type ordinance, typical mature tree
scores 5, then those pixels 3 canopy.

0.5 acres to <3 acres (count 218 to 2 0.5 acres was used for SFPUC Triple
<1,307), except when Vegetation Type Bottom Line

scores 5 then those pixels in paches

score 4

3 acres to <300 acres (count 1,307 to 3 3 acres is near the lower range of
<130,680), except when Vegetation home territories/ranges for small
Type scores of 5 then those pixels upland and riparian birds of

score 4 conservation concern targeted in the

at Green Visions project. Including
yellow-breasted chat, lark sparrow,
and rufous crowned sparrow.
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300 acres to <10,000 acres (count 4 300 acres is size of Deb’s Park which
130,680 to <4,356,000), except when has bobcat population.

Vegetation Type scores of 5 then
those pixels in paches score 4

10,000 acres+ (count 4,356,000+) 5 10,000 acres is threshold used in
California Essential Habitat Linkages
project.

3.4. Combine Patch Score and Vegetation Type Score {files call this Habitat Quality or Value) into
Overall Habitat Quality Score of 1-10 points.

3.4.1.Combine final output tables, latest versions are called “Lookup_Regio6 PTCHSCRMaster”
and “1_1b habqgl11”. Final combined Habitat Quality Score File is called: 1_1b_galptch6.
Spatial analyst>Local>Combine.

3.4.2.Add field called “QULPTCH_REP”. Add both scores for veg type and patch size together.
Adjust scorring for patches that score 5 for veg type per rules in table 3.3.2.4. above and...

3.4.2.1. Correct final score for streams that fall within LARIAC pixels classified as
developed/roads/built (these score 999 for patch sze in current file). Assume patch
score is 4 for pixels with habitat quality of 5, 3 for habitat quality of 4 or 3, 2 for
habitat quality 2 or 1.

3.4.2.2. Weighted and unweighted scoring was tested. Unweighted scoring is used for
all but natural areas that score 5 for vegetation type (habitat quality/value). This is to
ensure that all natural areas, large or small, in the City are valued at a very high level,
regardless of size.

3.4.3.Final output file for Omniscape is called source_fin3. Itis the same as the final habitat
quality score.
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APPENDIX G: Habitat Connectivity of Landscapes and Open Space GIS Methods

1. Datasets Used:

1.1. Results of Indicator 1.1b Habitat Quality of Landscapes and Open Space (and all associated
datasets)

1.2. Dataset 5 Name: SCAG Los Angeles Countywide Zoning 2008
1.2.1.Dataset Filename: zoning_countywide.shp
1.2.2.Dataset Location: \\htpgis3\General_Users\RAD

1.2.3.0riginal Source: https://egis3.lacounty.gov/dataportal/2012/04/10/countywide-zoning/

1.2.4.Dataset Discussion: Includes detailed zoning normalized by SCAG for all Cities in the
County. “Zone_Code" field is most detailed and includes densities. “SCAG_GP_CO” field
includes less detailed descriptions used in the County general plan. This field was
referenced in this analysis to identify schools.

2. Other Datasets Considered

2.1. NASA landcover TBD.

3. Method
3.1. Convert Habitat Quality raster file into “source weight” file to run in Omniscape.

3.1.1.Using Lookup. Current version called “source_fin3”. Note: Ocean should have no data (-
9999 in current Omniscape version) to reduce processing time.

3.1.2.Resample to 30’ pixels. Data Management Tools>Raster>Raster Process>Resample.
3.2. Prepare “resistance” file for Omniscape

3.2.1.Convert SCAG Land Use to 30’ raster grid from polygon. Remove or reclassify ocean
polygons classified as “GenWater” around the Port so they can be given same -9999 no
data resistance score as rest of ocean.

3.2.2.Expand grid to study area using boundary file (must be resampled to 30°).

3.2.3.Vegetated areas from the Source Weight file receive the reverse value for resistance (i.e.
10=1, 9-2, etc).

3.2.4.All pixels scoring zero (i.e. developed/built) are scored for resistance values of 20 or
greater. Reclassify the 100 SCAG LUOS types to 15 categories and assign scores based on
the following rules in the table below. Each of the 100 land use type descriptions were
reviewed during the reclassification process — many are duplicative and represent the
various conventions of planning agiencies who's codes were aggregated to produce the
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SCAG regional land use map LUO5. LUO5 was the most recent comprehensive compilation
by SCAG that covered the entire study area. The SCAG landcover dataset used for Green
Visions also looked good but SCAG folks couldn not find it. Resistance values are based on
resistance values used in McCrae et. al 2016 {Connecting Natures Stage).
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Source | Southern California Council ReClassified Land Use Resistance
Weight | of Governments LUO5 Code Weight

10 Varies Varies 1

9 Varies Varies 2

3 Varies Varies 3

7 Varies Varies 4

6 Varies Varies 5

5 Varies Varies 6

4 Varies Varies 7

3 Varies Varies 8

2 Varies Varies 9

1 Varies Varies 10
0 1111 Medium Density Residential 40
0 1112 Low Density Residential 30
0 1121 High Density Residential 50
0 1122 High Density Residential 50
0 1123 High Density Residential 50
0 1124 High Rise Residential 150
0 1125 High Rise Residential 150
0 1131 High Density Residential 50
0 1140 High Density Residential 50
0 1151 Low Density Residential 30
0 1152 Low Density Residential 30
0 1211 Office 60
0 1212 High Rise Residential 150
0 1213 High Rise Residential 150
0 1221 Commercial 300
0 1222 Commercial 300
0 1223 Commercial 300
0 1224 Commercial 300
0 1231 Commercial 300
0 1232 Commercial 300
0 1233 Office 60
0 1241 Office 60
0 1242 Office 60
0 1243 Office 60
0 1244 Office 60
0 1245 Office 60
0 1246 Office 60
0 1247 Commercial 300
0 1251 Commercial 300
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0 1252 Office 60
0 1253 Office 60
0 1261 Office 60
0 1262 Office 60
0 1263 Office 60
0 1264 Office 60
0 1265 Campus 30
0 1266 Office 60
0 1271 Campus 30
0 1272 Vacant 25
0 1273 Campus 30
0 1311 Industrial 75
0 1312 Office 60
0 1313 Industrial 75
0 1314 Office 60
0 1321 Industrial 75
0 1323 Industrial 75
0 1324 Industrial 75
0 1325 Industrial 75
0 1331 Industrial 75
0 1332 Industrial 75
0 1340 Industrial 75
0 1411 Transportation 75
0 1412 Transportation 75
0 1413 Transportation 75
0 1414 Transportation 75
0 1415 Industrial 75
0 1416 Industrial 75
0 1417 Industrial 75
0 1418 Transportation 75
0 1420 Industrial 75
0 1431 Industrial 75
0 1432 Industrial 75
0 1433 Industrial 75
0 1434 Water Infrastructure 30
0 1435 Industrial 75
0 1436 Water Infrastructure 30
0 1437 Water Infrastructure 30
0 1438 Water Infrastructure 30
0 1440 Industrial 75
0 1450 Transportation 75
0 1460 Transportation 75
0 1500 Industrial 75
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0 1600 Commercial 300
0 1700 Under Construction 45
0 1810 General Open Space 23
0 1821 General Open Space 23
0 1822 General Open Space 23
0 1831 General Open Space 23
0 1832 General Open Space 23
0 1840 General Open Space 23
0 1850 General Open Space 23
0 1860 General Open Space 23
0 1870 General Open Space 23
0 1880 General Open Space 23
0 2110 General Agriculture 30
0 2120 General Agriculture 30
0 2200 General Agriculture 30
0 2300 General Agriculture 30
0 2400 General Agriculture 30
0 2600 General Agriculture 30
0 2700 General Agriculture 30
0 3100 Vacant 25
0 3200 General Agriculture 30
0 3300 Vacant 25
0 3400 General Open Space 23
0 4100 General Water 30
0 4200 General Water 30
0 4300 General Water 30
0 4400 General Water 30

3.3. Run Omniscape using Julia 1.2.0

3.3.1.Had a lot of help from Vincent Land to get Omniscape installed and to run. There seemed
to be some bugs running it through Windows (they use Linux)

3.3.2.Extract subsets of study are as needed (improved computing power will be necessary to

3.3.2.1.
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Vincent Landau
Scientist

Conservation Science Partners, Inc.
5 Old Town Square, Suite 205

Fort Collins, CO 80524
www.csp-inc.org | 970 484-2898

model the entire study area in Omniscape). Extract by Rectangle is best (GIS often doesn’t
like irregular boundaries)
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extract by rectangle. You can tell because the Omniscape results include the full




study area but with a zero value (or maybe no data). | don’t think it is being
incorporated into the model (or else run times would be a lot longer). However, this
might be the reason that the normalized and potential current flow maps are failing.
Need to figure out how to completely get rid of areas outside of the rectangle.

3.3.3.Convert resistance and source raster files to ASCII file for Omniscape and Julia.
Convsersion Tools>From Raster> Raster to ASCIl. (There is a bugin ArcMap 10.5, select
second “file” for file type. First “file” is a .txt file second is a .asc file. Julia only reads .asc)

3.3.4.Install atest version of Julia and then Omniscape. https://julialang.org/downloads/,
https://github.com/Circuitscape/Omniscape.jl,
https://circuitscape.github.io/Omniscape.jl/stable/,

3.3.5.Create .ini file of Omniscape parameters using notepad (.ini file is the one that says
“configuration file” for file type). You have to save as .ini in the actual file name, otherwise
it saves as a “text file” file type from notebook. Start with beta test file here
(D:\Ecotopes\HabitatValuation\Connectivity\OmniGPTest) and adjust as needed based on
computing power and whether local or long distance connectivity is desired (i.e. moving
window size). .ini files are created in notebook {or similar), but when you save you MUST
put .ini at the end of the file name. Note that the computers | tested this on were not able
to run parallel processes (thus “false” for that perameter) which made this very slow.
MacArthur Park beta test of ~450K pixels and 4 mile moving window took 21 hours.
Example .ini file for MacArthur Park is here:
D:\Ecotopes\HabitatValuation\Connectivity\Omniscape MPTest\MPtest25.ini
(configuration file, not text file with same name)

3.3.5.1.1. Block size should be no more than 5% or so of the moving window size

3.3.5.1.2. # of parallel processes = the number of cores and/or CPU’s that the
computer has.

3.3.5.1.3. Full analysis extent will require a very large computer via Microsoft
Azure Cloud Service or similar. Looking at using the following: M64ls: 64
vCPU'’s, 512 GB Ram, with 2048 GB or Temp Storage for $5.415/hr .

3.3.5.1.4. Use Linux operating system is best. See “Docker” read me files on the
omniscape github site from Vincent.
https://github.com/Circuitscape/Omniscape.jl

3.3.5.2, Run Julia 1.2.0 for Test Area

3.3.5.2.1. Run Code Location for Elysian Valey:
D:\EcotopeshHabitatValuation\Connectivity\OmniGPTest
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J Julia_Omni_runCODE_GP - Motepad

File Edit Format View Help
cd("d:\\Ecotopes\\HabitatValuation\\Connectivity\\OmniGPTest")

julia> using Omniscape

julia» run_omniscape("GPTestl.ini" )|

33522 .ini file setup is below {there might be an extra set of row spaces in
here??) Note that | couldn’t run parallel processes. Might be an issue with
running Omniscape through Windows. Vincent uses Linux. {normalized flow
fails, possibly for reasons above)

J 3Ptest] - Notepad
File Edit Formet View Hep
[Input files]

resistance file = resgpl2.asc

source_file = srcgpl?.asc

[Options]

block_size = 11

radius - 86

buffer = @

source_threshold = @
project_name = GPtestl
calc_flow_potential = true
correct_artifacts = true
source_from_resistznce = false

r_cutoff = 9.0

write_raw_currmep - true
write_normalized_currmap = true

write Flow_potertizl = true

parallelize = fzlse
max_parallel = 4
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